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Disclaimer of liability

The contents of this documentation have been carefully checked for consistency with the hardware and
software systems described. Nevertheless, it is impossible to completely rule out inconsistencies, so that we
decline to offer any guarantee of total conformity.

We reserve the right to make technical modifications of the systems.

Copyright
© 2026 imc Test & Measurement GmbH, Germany

This documentation is the intellectual property of imc Test & Measurement GmbH. imc Test & Measurement
GmbH reserves all rights to this documentation. The applicable provisions are stipulated in the "imc Software
License Agreement".

The software described in this document may only be used in accordance with the provisions of the "imc
Software License Agreement".

Open Source Software Licenses

Some components of imc products use software which is licensed under the GNU General Public License (GPL).
Details are available in the About dialog.

If you wish to receive a copy of the GPL sources used, please contact our tech support.
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Notes regarding this document

This document is an excerpt from the manual of imc FAMOS. The manual for imc FAMOS is available both as an
chm and in PDF format. Click on the symbol (@ to open the help.

The program "imc Help and Documentation" (in the Start menu or via the menu ribbon "Help" > "Additional
Documents") provides you with access to the PDF-file and other documents.

What is the best way to read the imc FAMOS documents?

If you have already worked with an older imc FAMOS version, we recommend taking a look at the topic
"Update-Info" (What's new...). Here you can get a quick overview of changes and innovations implemented in
the current version.

Getting Started

Before installing the software, start by reading the document "Getting Started". This contains important tips
for achieving problem-free installation, as well as for operation.

All information presented in the document "Getting Started" is also presented in the imc FAMOS manual.

Manual - complete documentation

The manual serves as reference material. However, it is still recommended that you observe the entire
instructions in order to be able to use certain functions which are more interesting than obvious.

ReadMe

This presents info on changes and extensions in imc FAMOS which were implemented after this manual went
to print.

Tutorials

Following successful installation, we recommend working through the chapter "Tutoriall 141" in order to get
quickly acquainted with the workings of imc FAMOS. It familiarizes you with the imc FAMOS operating
philosophy and basic operations in a convenient manner.

Training programs for introduction to the systems, and advanced workshops

We recommend that before you begin working with imc FAMOS you participate in an extensive training
session. Such training will enable you to get started working efficiently much faster. Additionally, you will
obtain valuable tips and information on how to use the software more effectively. More information is
available on our homepage under "Service & Training" > "imc ACADEMY".

Special notes

o s

Warnings contain information that must be
observed to protect the user from harm or to
prevent damage to property.

© nNote op Reference

Notes denote useful additional information on a A reference in this document is a reference in
particular topic. the text to another text passage.
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Before you start Chapter 1

1 General introduction
1.1 Before you start

Dear user.

1. The software you have obtained, as well as the associated manual are directed toward competent and
instructed users. If you notice any discrepancies, we request that you contact our tech suggortm.

2. Updates during software development can cause portions of the manual to become outdated. If you
notice any discrepancies, we request that you contact our tech support.

3. Please contact our tech support if you find descriptions in the manual which you believe could be
misunderstood and thereby lead to personal injury.

4. Read the enclosed license agreementm. By using the software, you agree to the terms and conditions
of the license agreement.

0 Note Notes on the descriptions and the screenshots

e The help may also contain parts shared imc software components. These parts may differ from the rest
of the help in terms of style and structure. All help files are equipped with a full text search functionality
and have an index.

e The screen shots appearing in this documentation were created with a variety of Windows versions and
their appearance may thus differ from that of your installed program.

1.2 Tech support

If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26
E-Mail: hotline@imc-tm.de
Internet: https://www.imc-tm.com/service-training/

Tip for ensuring quick processing of your questions:

If you contact us you would help us, if you know the serial number of your devices and the version info of the
software. This documentation should also be on hand.

e The device's serial number appears on the nameplate.
e The program version designation is available in the About-Dialog.

Product Improvement and change requests

Please help us to improve our documentation and products:

Have you found any errors in the software, or would you suggest any changes?

Would any change to the mechanical structure improve the operation of the device?

Are there any terms or explanations in the manual or the technical data which are confusing?

What amendments or enhancements would you suggest?

Our tech suggortm will be happy to receive your feedback.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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Service and maintenance Chapter 1

1.3 Service and maintenance

Our service team is at your disposal for service and maintenance inquiries:

Phone: (Germany): +49 30 629396-333 (Mon.-Fri.: 9.00 - 12.00 and 13.00 - 17.00)
E-Mail: imc-service@axiometrixsolutions.com
Internet: https://www.imc-tm.com/service

Service and maintenance activities include, for example calibration and adjustment, service check, repairs.

1.4 Legal notices

Quality Management
7

System

ISO 9001:2015 1995 and DIN EN ISO 14001 certification since November 2023. You can download
150140012015 the CE Certification, current certificates and information about the imc quality

PR sy system on our website:

https://www.imc-tm.com/quality-assurance/ and in the download area of imc

: 3| Management imc Test & Measurement GmbH holds DIN EN ISO 9001 certification since May

. ®
TUVRheinland

imc Warranty

Subject to the general terms and conditions of imc Test & Measurement GmbH.

Liability restrictions

All specifications and notes in this document are subject to applicable standards and regulations, and reflect
the state of the art well as accumulated years of knowledge and experience. The contents of this document
have been carefully checked for consistency with the hardware and the software systems described.
Nevertheless, it is impossible to completely rule out inconsistencies, so that we decline to offer any guarantee
of total conformity. We reserve the right to make technical modifications of the systems.

The manufacturer declines any liability for damage arising from:
o failure to comply with the provided documentation,
e inappropriate use of the equipment.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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imc Software License Agreement Chapter 1

1.5 imc Software License Agreement

imc Test & Measurement GmbH

Voltastr. 5

13355 Berlin, Germany

Trade register: Berlin-Charlottenburg HRB 28778

Managing directors: Frank Mayer, Michael Jirgen Bilter, Michael John Flaherty

imc Test & Measurement GmbH
Terms and Conditions
Governing the Use of imc Test & Measurement GmbH Software
As of: July 9th, 2025

§ 1 Objects of the Agreement

(1) In addition to the "General Terms and Conditions Governing imc Test & Measurement GmbH Deliveries and Services to
Customers", these terms and conditions apply to all contracts concluded with imc Test & Measurement GmbH (hereinafter
referred to as "imc") which involve the transfer of rights of use to any software developed by imc (standard software,
software created or adjusted specifically for the Customer, which is recorded on the machine-decodable data carriers such
as data files, databases and database material, updates, upgrades, releases, etc., including corresponding documentation,
information and materials, hereinafter referred to as "Software").

(2) The Software is provided to the Customer as an executable object program on machine-decodable data carriers specified in
the "Objects of the Agreement". The Software's product documentation is also supplied to the Customer either in print or
on a machine-decodable data carrier. Unless otherwise expressly agreed in writing, the Customer is not issued the source
code of the Software.

§ 2 Rights of Use, Scope

With regard to any transfer of rights of use to Software created by imc, the following provisions apply:

(1) Basic provisions

a)

b)

c)

d)

The Customer is granted a non-exclusive and — subject to the terms and conditions governing the use of Software by
third parties, resale and leasing — non-transferrable right of use to the Software for its own purposes. "Use" signifies
running the programs and editing the data records.

Until each due fee is paid in full, the Customer is entitled to use the Software solely on a revocable basis. If the Customer
is in default with regard to the payment of fees, imc is entitled to revoke the use of the respective services for the
duration of the default. The Customer is granted the permanent right to use copyright protected services, in particular
the Software, only upon full payment of the agreed fee.

The Customer agrees to undertake appropriate precautionary measures to prevent unauthorized access by third parties
to the Software. The original data carriers and the data carries used to make copies as per the agreement, as well as the
documentation, are to be stored in a secure location. Employees are to be notified that the production of copies beyond
the scope of the agreement is not permitted.

If the right of use is revoked or expires due to another reason, the Customer is obligated to return to imc the Software,
the copies made by the Customer and the documentation. Provided that a physical return of the Software and the copies
is not possible due to technical reasons, the Customer is obligated to delete such and confirm deletion to imc in writing.

(2) Reproduction

a)

b)

c)

The Customer is entitled to make copies of the Software only if copies are necessary to use the Software in accordance
with the contract. The following are considered cases in which reproduction is necessary: installation of the Software
from the original data carrier onto the hard disk drive of the hardware used, as well as loading the Software into the
computer memory.

The Customer is entitled to create a backup copy if such is necessary to safeguard future use. Copies may only be made
for other purposes after prior written consent has been issued by imc.

The Customer is not allowed to make any reproductions other than those expressly permitted under the provisions of
this agreement.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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imc Software License Agreement Chapter 1

(3) Use of the Software by Third Parties, Resale and Leasing

a) The Software may be used for the purposes stipulated in this contract, in particular for the Customer's business
operations. Access to the Software may also be provided to parties which rely on using the Software as instructed by the
Customer. In particular, the Customer is entitled to operate the Software or allow the Software to be operated on data
processing devices, which are located on the premises of and are directly owned by a third party company (outsourcing).
The prohibition against multiple use remains unaffected.

b) The Customer may permanently sell or give the Software to third parties provided that the Customer is granted
permanent use of the Software. In the context of its period of use, the Customer may temporarily transfer the Software
to third parties for a fee or free of charge. The prohibition against multiple use remains unaffected. The Customer is
expressly notified that transfer to third parties is not permitted and use by third parties is technically not possible if an
individual license must be acquired or an individual activation is required for third party usage, such as in the case of
runtime licenses.

c) With regard to the valid use of Software by a third party, the Customer is obliged to ensure that the third party
acknowledges the provisions of this agreement governing the rights of use as binding for such third party. The Customer
may not transfer Software and documentation to third parties if there are grounds to suspect that the third party may
infringe upon the provisions of this agreement governing the rights of use, in particular with regard to the unauthorized
production of copies.

d) Subject to the provisions stipulated in § 4 Paragraphs 1 and 2 or a deviating express agreement in writing, the Customer
may not use the Software while the Software is being used by a third party (prohibition against multiple use); in the event
that the Software is transferred to the third party, the customer is obliged to surrender to imc all Software copies
including, if applicable, all existing backup copies, or to destroy copies not surrendered.

(4) Decompilation

The reverse translation of the provided program code into other code forms (decompilation), disassembling and other forms
of reverse engineering of the various production phases of the Software is not permitted. If interface information is required
to achieve the interoperability of a separately created computer program, such may be requested from imc, or a third party
to be named by imc, for a minor fee. Section 69 e of the German Copyright Act ("UrhG") remains unaffected by this
provision.

(5) Changes by imc

If imc conducts adjustments, changes or enhances the Software on behalf and on account of the Customer, the Customer
thus acquires the corresponding rights of use to the changes or enhancements of the Software to which he is entitled
according to the stipulations of this agreement.

(6) Exceptional Usage Requests by the Customer

If the Customer requests to use the Software according to terms which deviate from the requirements stipulated in
Paragraphs 2 through 5, this exceptional use of the Software must be agreed in writing by imc. In such an instance, the
Customer agrees to provide imc with information about the desired scope of use, the pertinent field of application, etc. If
imc subsequently grants a license covering the Customer's special intended use, the parties agree that a new license fee is
owed by the Customer, which is independent of payments made by the Customer for the previously existing license.

§ 3 Copyright, Protection of the Software

(1) The intellectual property, in particular the copyright as well as all industrial property rights and trade secrets, are retained by
imc and are not transferred to the Customer. The Customer's ownership of the machine-decodable data carries and data
processing units remains unaffected.

(2) Copyright notices, serial numbers as well as designations and reservations of rights which serve as program identification or

a protective right may not be removed or changed. The Customer is obliged to transfer the existing protective right notices
to all copies. In particular, backup copies of the Software must be expressly designated as such.

§ 4 License Types, Multiple Use
(1) In the case of a Single-User License, the Software may be activated and run on only one data processing unit. "Activation"
refers to the process of transferring the license to the data processing unit.
If the technical specifications for the Software permit a second activation, then the Customer may additionally activate the

Software on a second data processing unit. However, the Software may only run on one data processing unit at any one
time, not on both simultaneously.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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imc Software License Agreement Chapter 1

(2) With a Network License, the Software may be run on as many data processing units as the amount of licenses obtained. In
this case a central data processing unit acts as the license server for which the activation process is performed.

If the technical specifications for the Software permit a second activation, then the Customer may additionally activate and
run the Software on as many data processing units as the amount of licenses obtained. However, these additional data
processing units must be used by the same users who operate the Software via the license server.

(3) Subject to the provisions in Paragraphs 1 and 2 or a deviating express agreement in writing regarding network use, multiple
use of the Software is not permitted.

(4) If the data processing unit is changed, the Customer is obliged to delete the Software from the hard disk drive of the
previously used hardware.

§ 5 Software-Subscription
If the Software used is a software-subscription, the following additional restrictions apply:

(1) The right of use is valid for a limited time period. The start and end of the time period are specified. After the end of the
time period, the right of use is expired.

(2) If the Customer wishes to continue using the Software after elapse of the specified time period, the subscription must be
renewed.

§ 6 Trial Version
If the Software used is a free trial version, then the following additional limitations apply:

(1) The trial version only entitles the user to test the Software. In particular, commercially productive utilization is not
permitted.

(2) The rights of use granted expire after the elapse of a period stated in the product description.

§ 7 License Key

(1) Upon delivery of the Software the Customer receives a License Key. Using this License Key, the Customer is able to activate
the Software purchased. By means of this License Key the Customer can also view his license status and order updates and
upgrades.

(2) The License Key is to be protected against access by third parties in order to prevent misuse. If, however, a third party gains
unlawful access to the Key, the Customer is obliged to notify imc immediately via telephone, as well as in writing, so that the
previous License Key may be suspended and a new one issued.

§ 8 Conclusion

(1) The law of the Federal Republic of Germany shall apply under exclusion of private international law. The provisions of the UN
Convention on Contracts for the International Sale of Goods (CISG) do not apply.

(2) The place of performance for all obligations arising from this agreement is imc's registered seat. Insofar as the Customer is a
merchant as defined by the German Commercial Code (HGB), a legal entity under public law, or a special asset under public
law, the exclusive place of jurisdiction for all disputes directly or indirectly arising from the contractual relationship is agreed
as imc's registered seat. The same applies to persons who have no general place of jurisdiction in Germany, as well as to
persons who have moved their place of residence or usual whereabouts abroad since conclusion of the contract, or whose
place of residence or usual whereabouts is unknown at the time the action is filed. In addition, imc is entitled to file suit at
the statutory venue.

(3) Oral side-agreements are not valid. Deviating or supplementary conditions as well as modifications of this contract, including
this written requirement clause, are only valid if agreed in writing and expressly marked as a modification or supplement.

(4) If certain provisions of this contract are inoperative or unfeasible, this does not prejudice other provisions of the contract.
The contracting parties agree to contractually substitute an operable provision which approximates the commercial
intention of the contract as closely as possible for any inoperable one.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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Chapter 2

2 Foreword

imc FAMOS (Fast Analysis and Monitoring of Signals) is a software program for analysis and evaluation of
measurement results. With an extensive range of functions conceived especially for the needs of measurement
and control applications, imc FAMOS eliminates much of your routine work in a comfortable fashion.

With imc FAMOS , you can process large data sets quickly and efficiently and create computational procedures
using standard mathematical notation. No specialized programming expertise is required! Furthermore,

imc FAMOS offers powerful means for displaying your data in charts or tables and for printing these in
individually designed reports.

imc FAMOS processes measured data produced by imc devices (e.g. imc CRONOS, imc C-SERIES). The scope of
functions also includes a large number of import- and export filters for common file formats (e.g. the standard
formats of different manufacturers of measurement devices).

The task of importing data into an analysis program which are not expressed in a directly supported file format
is often the first and most difficult problem involved with analyzing measured data. Toward this end,

imc FAMOS offers support in a variety of ways: for simple ASCII formats, for example, a flexible and easily
configured Assistant is provided. For more complex formats, the imc File Assistant can be used, by which
means the user can personally create import filter, even without possessing any programming skills.

imc FAMOS is principally conceived for use in offline evaluation of data and cannot be used to control
measurement instruments

imc FAMOS can be expanded with add-on modules and function libraries. Expansions are available which, for
example, make it possible to design digital filters or to classify measurement data. Furthermore you can add
your own self-written function libraries to imc FAMOS.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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System requirements Chapter 3

3 Setting up - Software
3.1 System requirements

Supported operating systems

Windows 10*/11* (64 bit)

Windows 2016/2019/2022 Server (64 bit)

*released in conformance with the version of Windows 10 /
Windows 11 applicable at build date of imc software

For the purpose of assigning imc FAMOS network licenses by means
of the License Manager, support of Windows 2003 Server continues.

Minimum requirements for the PC

Processor with 1 GHz

2 GB RAM

1 GB free hard disk drive (NTFS format)

Languages:
German, English for programming. GUI also supports Japanese , French, Chinese, Korean partially.

Microsoft © Excel:

In order to be able to import or export files in Microsoft ® Excel format (*.xlIs,*.xlsx), Excel must be installed
on the same computer. The following versions are supported:

e Excel 2010, 2013, 2016, 2019, 2021 (except "Starter Edition"), Microsoft 365*

*released in conformance with the version of Microsoft 365 applicable at build date of imc software

Other operating system components

The following components are installed with the imc FAMOS setup if they are not already present:

Component Version Folder in "OSUpdate" directory
Microsoft .NET Framework  4.8.3761.0 ndp48-x86-x64-allos-deu.exe
4.8.4115.0 ndp48-x86-x64-allos-enu.exe
Microsoft VC 2022 14.31.31103 VC2022
© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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Installation Chapter 3

3.2 Installation

Windows must be correctly installed and all system requirements must be assured before installing imc FAMOS

To install imc FAMOS, start the program "Setup_ImcFamos_X64.exe" from the root directory of the installation
CD.

Alternatively you can select the "Software" icon and subsequently the command "Install".

Administrator rights required

For the purposes of installation and uninstallation, a user account with administrator privileges for the PC is
required.

If you are logged on to the PC without administrator rights, log yourself out and log back on with an
administration-level user account. If you don't possess the appropriate account type, you will need the
support of your system administrator or IT department.

Select the edition of imc FAMOS to install:

Help Info

> Activation with License Key via Internet ...

> Activation of Trial Versions via Internet __.

Product Version Install License

imc FAMOS Demo-Version (30 Tage kostenlos nutzbar) + FAMOS Reader 7.0 License via network service
imc FAMOS Enterprise 7.0 License via network service
imc FAMOS Professional 7.0 License via network service
imc FAMOS Standard 7.0 License via network service
imc FAMOS Runtime 7.0 License via network service
imc FAMOS Reader (kostenlos nutzbar) 7.0 Freeware

r r

License state: () All licenses for the selected products are available. License server:

. @  Access successful.

» Configuration

F

Internet:

Mot yet accessed.
» Configuration

» Continue Setup
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Installation Chapter 3

The licensing procedure must precede the installation. Select the edition you have acquired.
Start the licensing procedure by selecting the link "Activation with License Key via Internet..."

The Reader-version does not require licensing. To test the Enterprise version for 30 days, license it using the
link "Activation of Demo Versions via Internet..."

For details on licensing, see here.

Follow the Assistant's instructions and select your preferred language for the online help files and example files
like projects, sequences and dialogs.

In the subsequent dialog, the license agreement appears. Once you have accepted its provisions, select the
installation folder to which to copy all the files.

The installation folder must be on the PC's local hard drive. imc FAMOS cannot be installed on a network drive.

This base directory will be structured with various subdirectories where, for example, sample files are
deposited. The subdirectory \BIN, for instance, contains all executable files and program libraries; the
subdirectory "\SEQ" sample sequences (macros); the subdirectory "\DAT" has measurement data files
containing information in various file formats.

At installation, you must also supply a name for the program group; the installation program will then
supplement the Windows Start menu with a corresponding entry. If, for instance, you specify "imc" as your
group name, you will be able to call the program from the submenu "Start/ Programs/ imc".

3.3 Start

Start imc FAMOS either via the corresponding entry in the Windows Start menu, or by clicking on the shortcut
on the Windows-Desktop which was created during the installation, or directly by calling the file "famos.exe"
from the Windows Explorer.

Licensing

The software license is administered by a License Manager. A detailed description is located in the users
manual. Earlier versions had been copyright-protected by a hardlock (blue dongle). As of imc FAMOS 6.1 this
will no longer be required. If you wish to exchange an old imc FAMOS hardlock for the License Manager, please

contact our tech suggortm.

This document refers to the user's manual for detailed information. You can now begin by working through
the chapter Tutoriall 1. The subsequent chapters provide an overview of the User Interface.
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4 Tutorial
4.1 Introduction

This chapter has been provided to acquaint you with some of the main features in imc FAMOS . After working
through this chapter, you should be familiar with the basic functions. When performing more complex tasks,
please refer to the relevant chapters for more detailed information.

The tutorial will demonstrate how to load a data set from a file and how to perform analysis using formulas.

You will also display channels in graphs and create an automatic sequence. Efficient use of the File Browser for
quick loading of files and for comparing data files is demonstrated.

Many of the commands used below can be called in several ways - via the imc FAMOS main menu, or via the
respective context menu (right-click of the mouse), via the corresponding icon in the toolbar or by a

combination of certain keys. In order to familiarize you with all of these options, they are each used in turn in
the discussion below, or at least mentioned as alternatives.

If you encounter unfamiliar terms in the discussion below, refer to the manual chapters 'User-Interface’,
'Appendix’ and the help for MS-Windows.

0 Note

In order to be able to follow the tutorial on the PC, at least the imc FAMOS Standard Edition is required.
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4.2 Starting FAMOS

After successfully installing, start imc FAMOS either by accessing the shortcut installed in the Windows Start
Menu or desktop.

The Start screen appears:

= | # B imc FAMOS Enterprise

File Variable Extra View v | e

Favorites Actions Tools Templates  Assistants Demos

111
i

iy

Help

a S Load Data Load Data .
Switchltalmainjview (with data source browser) (with file dialog) (WiitelSequence
Options
¥ Restart - -
] ]

% Exit

TUTORIAL WHAT'S

NEW
VAN N
New Report (Portrait) Show Tutorial What's new?

M
Import: Import . 5 Export: Create EXCEL export
ASCII/CSV/EXCEL-file DemotiCurvelDisplays template

Recently used Pinned

- DataBrowser - Trains stops .
& C:\Users\Public\Documents\imc\imc FAMOS\_Demo Projects\DataBrowser - Trains stops ey EREEEEE
- Race 24h
i=Y

C:\Users\Public\Documents\imc\imc FAMOS\_Demo Projects\Race 24h ety EREEEER

imc FAMOS start screen

The start screen is the entry portal to imc FAMOS. Assistants and templates can be opened from here. A
detailed description can be found in the chapter The start screen.
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Chapter 4

By clicking on File, FAMOS switches to the classic view:

imc FAMOS Enterprise

File Variable Extra View
© o oz
Standard ]
grE@Ev@|W|E- ¥-
Name Value
©@ o=
p Search folder -~ & - Subtraction sample-wise
@ Last @ Smo  Smoothing over intery
Y Favorites © ABCRating A, B or C frequ
> Q Libraries @ FFT Fourier transformatior]
Q All & SearchLevel Search level/s
> Basic Functions & Cut Cutsamples (at x)
> / Editing @ RSamp Reference sampling
v "ﬁ Analysis & MVRMS Maving RMS
> O Statistics & dB Convert to decbel
H Seek  Diff Differentiation
> Fr1 Spectral Analysis @ LFit Linear regression
g Acoustics & ICreateSignal.Sine  Create
<%~ Vibration Analysis o FOR Loop (Counter)
> (2 Order Tracking C PI Cirde constantPI = 3.1
> T Class Counting
S\\S Durability and Fati
P EectricPower [
4 » 4 »
Ready

=| Input

0ODS Browser |

o Browser

w2 ‘ Sample data files

v [ V] sample data files
> EXPERIM
> Vibration

Name
EXPERIM
Vibration

] AC_Data_Sample. ...

] Adsinus.dat

[~ Anstieg.dat

b~ Arch.dat

i) BusTrip.dat

] Current.dat

[~ Damped_Harmonic...

[~ Distance_free_fal...
] G_spec.dat

[ Limited_grow.dat
b~ Porsche.dat

[~ Predict.dat

b~ Rpm_v.dat

[ Sin3.dat

[~ Sintest.dat

b~ Slope.dat

4

A |Size

Output = Help  QuickView

‘eoo|rfe@ ¥

199 KB
37KB
2KB
4KB
344KB
6 KB
626 KB
2KB
3KB
32KB
1KB
20 KB
13KB
3KB
10KB
2KB

Last chan..

1/1/202
1/1/2021
1/1/202
1/1/202
1/1/2021
1/1/2021
1/1/2021
1/1/202
1/1/202
1/1/2021
1/1/202
1/1/202
1/1/202
1/1/202
1/1/202
11202

3

File:
imc\ime FAMOS'_Demo Pr:

\Anstieg.dat

QOrigin:

Channels:
Samples:
Sampling intervals [s]:
Datatypes:

Groups:

Texts:

Textarrays:

TSAs:

Nacrrintian Rlnh.

Channel:
Parameters:

C:\Users'\Public\Documents
ojects\_Demo Files\dat

Famos

1

391
0.00001
Simple

0

0
0
0
n

anstieg
Samples: 391, Type: Simple, Inte

CAPS  NUM  Variables: 0

FAMOS: Main window in standard set-up

If the main window appears differently from the illustration here, select menu "View" / "Return to Default" in
order to restore the default configuration.

The workspace below the menu bar and tool bar is divided into 5 boxes:

Function list, displaying all available functions and commands.

Variable list, displaying all channels and variables currently being processed.

Plug-in window, in which the separate user interfaces of extension modules are displayed. The File

Browser plug-in is permanently available for fast access to measurement files. By default, this window is
minimized, meaning that only its title bar is visible.

e Output window, displaying help texts, error messages and warnings

Editor window, for entering and executing individual operations and sequences (macros)

The basic arrangement of these boxes is fixed (e.g., the variables list is always at the upper left), but the size
and visibility of the boxes can be altered. For instance, it's possible to grab the border between 2 boxes with
the mouse and move it, or use the corresponding buttons to minimize or maximize a box

© 2026 imc Test & Measurement GmbH
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Directories Chapter 4

4.3 Directories

Select the item "Options" in the "Extra” menu. The dialog which then appears presents all the presettings
influencing imc FAMOS ' behavior. These are organized in various sections which can be selected from the list
at left. Select from here the entry "Folders". A dialog box appears, in which you can set the default folders.

E-=
f(] Functions
L[_I:L Variables List Load data files from:  D:\_Schulung\Trainingsp \englischlimc FAM
----- Standard wiew Save data files to: E:\imc FAMOS\dat
o Measurement View sequences fDialogs:  CriimciSeq
= Editor Curve configurations:  C:\imc\Cov
Curve Window Reports; C:\mc'\Drb
& Colors Definition files: C:\ProgramDatamc\Common \Def
&l Browser Projects: c:\imc\Projects
----- Data sources a| | _;I
e More
Tz File Browser (6.3) ID:\,_Sn:huIung‘-,Trainingspad:s‘n,englisd'u‘n,im-: FaM! Browse... | 'l

Dialog "Determine default directories"

The selected directory may be changed either in the input box or by calling a dialog with "Browse", which
searches existing directories or can create a new directory.

If you have completed installation of imc FAMOS and have selected the folder "C:
\Users\Public\Documents\imc\imc FAMOS" for sample files, the subfolders should appear as follows:

"Load data files from:" C:\Users\Public\Documents\imc\imc FAMOS\DAT

"Save data files:" C:\Users\Public\Documents\imc\imc FAMOS\DAT
"Sequences:" C:\Users\Public\Documents\imc\imc FAMOS\SEQ

"Curve configurations:" C:\Users\Public\Documents\imc\imc FAMOS\CCV
"Reports:" C:\Users\Public\Documents\imc\imc FAMOS\DRB
"Definition files:" C:\ProgramData\imc\Common\def (depends on system, read only)
"Projects:" C:\Users\Public\Documents\imc\imc FAMOS\Projects

If unwanted directories are entered, simply change the appropriate entries. Confirm changes with <OK>,
otherwise <Cancel>.
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4.4 Loading Files

J- 1@ @ ® Inthe multi-function bar "Variable", select the menu item "Load". A dialog appears
for loading a file. Set the file format "imc FAMOS " below left in the format list. All
data set examples are listed in the directory box. Double-click on "slope.dat" or select
the entry and then press <OK> to load the file.

B &g o]

Variable
= =
Fave together Save individually

File

Extra View

x
Loak in: I . Dat j .@ 5.0 B &-

Mame = |v| Date modified | vI Type |:|
g klsection3.dat 1/10/2013 8:27PM  imc Melidaten
Recent Places k~lsin_Cos_fuer HREMC.dat 8/8/2012 3:51PM  imc Melidaten
kdsIME.DAT 6/7/1996 2:00 AM  imc Meldaten
D B SIME.DAT 6/7/1996 2:00 AM  imc Meldaten
Desktop blSINTEST1.DAT 6/71996 2:00 &AM imc Mefidaten
blSINTEST2.DAT 671996 2:00 AM  imc Meldaten
H blSINTEST3.DAT 6/7/1996 2:00 AM  imc Meldaten
Libraries B~ SINTEST4.DAT 6/7/1996 2:00 AM  imc Mefidaten

- blSINTESTS.DAT 671996 2:00 AM  imc Meldaten J
IL; E~smus.DaT 6/28/1993 2:00 AM  imc MeBdaten

imc Mefidaten
imc Mefidaten

9/18/2013 9:16 AM
6/17/2013 3:19 PM

Computer

k~slope Square.DAT
‘slope.dat
E~so2.0aT

&/7/1996 2:00 AM  imc Melidaten _|;|
Metwork ! I I >
File name: Islnpe.dat j Open I
Files of type: [FAMOS (" dat:* raw) Cancel
Help

[ |
_ b |
Options. .. |

| 08/17/13 15:19:53 1833 Bytes

4

Dialog "Load FAMOS file"

The dialog box is closed and the file opened. The variable s1ope appears in the list.

imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
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4.5 Showing Variables

Select the entry s1ope in the variable list by clicking on it once.

Press function key F4 or select item "Show together" in menu "Variable". A curve window displaying the
|_dchannel appears, with the variable's name as the title.

A siope ~1o1x|

File Edit Configuration Options Extras

BEH A E SR G- O- |k @)

v

35-
30-
25-
20-
15-
10-
I I I I I 1 I I
0.0 0.5 1.0 1.5 2.0 25 3.0 35

Curve window with variable "slope"

Move and enlarge the curve window somewhat and shift it away from the lower right corner of the screen.

4.6 Zoom

Select "Zoom" in the menu "Edit". The mouse cursor takes the shape of a vertical arrow.

Stretch a selection rectangle around the desired region while holding down the left mouse button. The region
is displayed with its colors inverted.

asope =
! File Edit Configuration Options Extras
" ~y Ll L =
S RAE S8 G- O k@
W
35-
30-
25-
20-
15-
10-
1 1 1 1 1 1 1 1
0.0 0.5 1.0 15 20 25 3.0 35
ms
Curve window with zoomed section
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Select a range and release the mouse. The selected range is enlarged.

aspe RI=TEY

File Edit Configuraton Options Extras

GH QA EEESB 0k

v

35-
30-
25-
20-
15-

1.4 1.6 1.8 2.0 22 2.4

Curve window with zoomed waveform

To enlarge the curve section even more, simply repeat the process. Use the "Back" function if you wish to
reverse the effects of the last actions.

Reference
'Curve Window' documentation, section 'Zoom

4.7 Unzooming

Select item "Unzoom" in the curve window menu "Edit". The whole waveform can be seen again.
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4.8 Measure

To open the "Measure" window, select "Measure".

Two measurement cursors (crosshairs) appear in the curve window. The curves' values at the position of the
measurement cursors are displayed in the measurement value window.

The x-value of the left crosshair is indicated by "xI = ..." and likewise with the right crosshair ("xr =..."). The
difference between the two x-values is indicated by "dx =..." (dx = xr - xI). In the same way, "yI" and "yr"
display the y-values of the two crosshairs. To move a crosshair, simply press the right or left mouse button and
drag the it to the desired position. The crosshair follows the path of the waveform.

N Measure: slope x|

ul = 1.420 ms
ur = 2361 ms
s = 0941 ms
T - = 33549 W
w |slope | - 24946

[yr - = = 1.397 W

M [=[f

File Edit Configuration Options Exfras

S R A =SB Gk @k

W

35-
30-
25-
20-
15-
10-

1.4 1.6 1.8 2.0 22 2.4 2.6

Curve window with measurement cursors (crosshairs)

The horizontal line tracks the curve's y-value.

As soon as you release the mouse button, the measurement results are displayed in the "Measure" window. By
pressing moving the mouse while holding down both mouse buttons simultaneously, you can obtain
measurements applicable to a constant dx. To quit the "Measure" mode, simply close the "Measure" window.

Reference
Curve Window' documentation, section 'Measure'

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
Page 21



Measure

Chapter 4

4.9 Properties

If the entry "SLOPE" in the Variables list is not displayed in inverted colors, select it by clicking on it.

i )In the menu "Variable" select the item "Properties" (alternatively, push the function key F5 or click on the

corresponding symbol in the toolbar).

A dialog box of information on the data set "SLOPE" appears, containing its length (number of data points),

sampling interval, units and comments.

Characteristic values IStruch..lrE I Cisplay I Data format | User-defined I

X|| Properties which cannot be
edited are displayed in the
background color (usually gray).

To exit this dialog, select

<Cancel>.

Mame:
Data type: I Mormal data set
Data format: I Real 4 Byte
Comment: I
Group: I
Measurement: I
Filename: I C:\imc\Dat\slope. dat
¥-Unit [v
Totalsize: | 391 X-unit E
X0 [0 X-Delta | 1e-005
Createdon: | 06/28/93 01:00:00
il il QK I Cancel Help

Dialog: Properties
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4.10 Interpolation

If you have zoomed extensively in the curve window, you must have noticed that the plot of the data set
"SLOPE" is jagged. The channel consists of a finite amount of points. The graphical display in the curve window
simply connects the data set's points by straight lines. If you wish to smooth the curve, you can generate a
new data set on the basis of "SLOPE" by means of interpolation. To do this, enter the following formulain a
new line in the Editor box:

d Browser | |=|Input This creates a variable Interpol. This new
1 - G | 4 | e | R R variable has a point density ten times greater

|ﬂ|nterpn|=lpnl[slupe, 10) than the data set slope.

"IPOL" is the name of the imc FAMOS function which performs such interpolation. This function has two
parameters, the data set to be interpolated (here: "Slope") as well as the interpolations factor
(here: 10). The result of this calculation is then assigned to the newly created variable "INTERPOL".

Enter the formula by proceeding as follows: first, type
"INTERPOL ="

Next, in the Functions box at left, select the
branch Edit\Interpolation.

,O Search folder - Lip Linear interpolation i .
— : Alternatively, select Search folder and enter the
(L}] 5 @ Ipol Spline interpolation

Functions # O n

' o LRt Linear regression word Interpolation.
# EditData » eFit Exponential regression Select the function Ipol.
@Transfc.rm | @ Poly Palynomial spline
& Appro  Function approximati

| ~¢ Interpolation, Appr... o Envelopel Envelope caloula

#zen Smoothing & Envelope? Envelope calcula
Input box with formulas

Double-clicking on the entry IPOL copies the function name along with its corresponding parameter mask to
the current position in the editor window.
INTERPOL = IPol(,)

Next, double-click in the Variables list on the entry "SLOPE" (to the right of the symbol). The variable's name is
copied to the Editor box:
INTERPOL = IPol (SLOPE,)

Click once with the mouse between the comma and the right parenthesis and type in 10. The formula is now
complete.

Now, we can test the formula. The line just entered must be denoted as the active formula. To do this, double-
click on this line, which then is shaded light gray, and to the left of the line a little arrow button then appears.

3 Browser | =) Input Thus., the currently active Iin.e i§ denoted in an
: - unmistakable way, and by clicking on the button,
G| +D2E| 2

1 EREP { the formula in this row is carried out.
=y Ipol( slope, 10)

Execute command line with button
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Click on the button circled to execute the formula. If the formula was entered incorrectly, an error message
appears. Correct the formula before attempting to execute it again.

Alternatively, you can use the combination of keys "CTRL" + "ENTER" to activate and execute the line with the
input cursor.

Once the formula has been successfully calculated, the entry rnterpo1 appears already selected in the variables
list. Use function key F4 or the appropriate button in the tool list to view data set 1nterpo1.

asope RE=EY
! File Edit Configuraton Options Extras
| R A (] S Ok D 2
— zlope — Interpol
W

19.0-

18.5-

18.0-

17.5-

17.0-

16.5-

16.0- \ \ \ \ ; : :

1.50 1.52 1.54 1.56 1.58 1.60 1.62 1.64
ms

Curve window with variable 'INTERPOL'

Close the curve window and activate the window siope. Select "Unzoom" to view the entire curve.

Remarks
e Function and variable names can also be entered in the editor window using drag&drop. Refer to chapter
'‘User Interface’, sections 'Variables List' and 'Function List'.

e As an alternative to the methods of manually entering formulas named, the parameterizing Assistant can
be used. To access this, select the function "IPOL" in the functions list and use the combination of keys
"SHIFT" + "F1", or select the corresponding menu item in the function list's context menu.

o |f you select a function in the functions list or click on a function name in the input box, then a short
description ("Quickhelp text) of the function appears in the output box.

Reference
Chapter 'Functions’, Section 'Function Assistant'.
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4.11 Two channels in Curve Window

For better comparison of two curves, display both in the same curve window.

To do this, right-click in the curve window. In the context menu which then appears, select the item "More
Channels...". In the following dialog, you can select additional variables and configure their appearance in the

same curve window.

_io/x]
W aveforms Channel infa

Ames List @ Ayailable ‘W aveforms

{1

T ow
kh slope

W aveforms in axes list—————— "W avelorm Prezelection

Components: | 777 - [T Single values

#='-plat: el - Wildcardz I“

<] i

k. I Cancel | ¥ Apply changes Set az default T opic

| List containing all of the available waveforms. Drag & Drop the desired ones to the axis of choice.

FAMOS: Dialog "More channels in curve window"

All data sets available for selection are listed in the list at right. The channels already displayed are indicated in

the list at left.
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Click on the data set interpol in the right list and drag the mouse while keeping its button pressed to the
left list below the variable sIope. Next, enter interpol in the left box as the second curve. Click the
leftmost of the three screen buttons and click onto the interpol entry, in order to cause this waveform to
be displayed in the curve window, sharing the x-axis of s1ope, but featuring its own y-axis.

o

W aveforms Channel info
Aues List @ Axnailable W aveforms

el -l Interpol

£ kL zlope
13
kL slope

o2

bl Interpol 4 | | _;I

—Waveforms in axes list———— W awveform Prezelection

Components: | 777 - [T Single values

w-plat; el - Wildcards I

<] i

] I Cancel | ¥ fpply changes Set az default T opic

| List containing all of the available waveforms. Drag & Drop the desired ones to the axis of choice.

Curve window with two curves

Click on the screen button <OK>. The dialog is closed and the curve window redrawn, with two y-axes for two
curves.

0 Note

The same result could be achieved by employing drag&drop on the data set's entry in the variables list;
depositing the entry in the middle of the curve window.
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asope I=TES
zlope Interpol
v v
94— = 34
33- = i3
32 - = 32
31 - = 31
| | 1 | |
1.410 1.415 1.420 1.425 1.430
ms

Curve window with two curves (separate axes)

In order to compare two curves, it is useful to set the same value range for both curves. Double-click between
labels of the right (2"9) y-axis or select the menu item "Axes"in the curve window menu "Y".

A dialog box for scaling the axis appears.

FAMOS: Dialog for scaling y-axes

Select "Range selection/ Like previous axis" (base axis is the

Scale [ Arrangement " Text " Attributes
Awes List @
]
H 1T: I Fange selection: Like previous axis

left y-axis).

We also wish to change the line style with which the curve "interpor" is drawn. To do this, push the button

"Topic" and from the menu which appears, select the item

"Lines...".

Labeling Legend Extraz

| | |

Lines I

Crozs sechions l

BEOE R

Line type: I Ciats [zmall) j
Symbaol: I Ma j
Line thickness: [ 2wpt — ]
Calar: Iautn:n LI
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Select from the axes list at left the data set "INTERPOL". Then select under "Line type" the item "Dots".

Select <OK> to close the dialog box. The curve window is redrawn. The right y-axis is deleted; the left y-axis
applies to both curves, and is scaled according to the setup in the dialog box for selecting the range. The
second curve (data set INTERPOL) is represented by a dotted line.

asope =1k
— clOpe ++ |nterpol

W W
34 - = 34
33- = 33
32 - = 32
31 - = M

I I 1 I I
1.410 1.415 1.420 1.425 1.430

Curve window with two curves (common axis)

0 Note

The same result can also be achieved using the previously discussed dialog "More channels in curve window",
by selecting the y-axis in the axes list and clicking on the Delete icon.

Zoom into close range to see the dots clearly.

To make the two separate waveforms yet more distinct, display the data set s1ope (1st curve) in a stair-step
display.

To do this, select the menu item "Configuration/Lines". From the axes list which appears at the left of the
dialog, select the item "SLOPE".

Select "Steps" in the menu "Line type" selection list and then select <OK>. Zoom in the new curve display. Here,
the function "IPol" was used to interpolate the data set s1ope through cubic splines.

asope =10] x|
— clope *+ |nterpol
v
19-
18-
17—
18-
15-
1 1 1 1 1
1.50 155 1.60 1.65 1.70
ms
Curve window with two curves in different display types
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4.12 Changing a Formula

Change the formula to get a lower interpolation factor.
INTERPOL = IPol (SLOPE, 3)

There are two ways to do this:

Changing the formula in the Editor
Use either of the keys BACKSPACE or DELETE to delete characters and change the parameter.

To apply the change, press the key combination Ctrl + ENTER. Alternatively, activate the line by double-
clicking and then click on the "Execute"-button. The curves displayed are updated.

Calling the Formula Assistant from the Editor

Click on the function so that the cursor is on the blue letter. Press SHIFT + F1.

_ || The Formula Assistant for the IPol()

Interpolate a waveform using a cubic spline, function appears with the parameters
entered. The function is selected in the
Editor. Change the parameter in the
Assistant and click on "Execute". In the

Interpolated waveform: I Interpal j

_ curve window, you can observe the
Starting waveform: |S|D|:lE j . . L .
change directly. if you are satisfied with
Interpolation factor: E the result, you can overwrite the line by
clicking on "Copy" in the Editor.
Execute | Copy Close |

Interpol = Ipol (slope, 3)

Open Formula Assistant with SHIFT + F1

askee =k
— clope ++ |nterpol

W

19-

Curve window with two curves in different display types
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4.13 Single Values

Calculate the maximum of the data set siope. Enter the following formula in the Editor box on a new line:
Maxim = Max (SLOPE)

The function "Max" is found e.g. in the branch Analysis\Statistics of the Functions tree diagram.

After the formula has been executed by pressing "CTRL + RETURN", a further entry appears in the variable list:

Earizlcnles | - D_ The dice symbol shows that the value is a single value, occupying no
L slope

kL Interpal | extent of time, in contrast to the data sets s1ope and interpol. If the
Mawimn  [=36.9745] value of the variable "Maxim" is not displayed, activate the option "Single
value: show content" in the dialog "Extra/ Options/ Variables list...".

The value can also be displayed in a single value window by pressing F4.

TR _iBix]

File Edit Configuration Options Extras

maxim = 36.97 V

Single value window

4.14 Calculations

A new data set is to be generated by reducing the data set s1ope by its mean value:
FREE = SLOPE - Mean (SLOPE)

The function "Mean" (e.g. in the branch Analysis\Statistics\Standard of the Functions tree diagram) calculates
the arithmetic mean of the specified channel. This mean value is subtracted from the data set slope.

Execute this formula and display the data set "FREE" by clicking on the curve symbol in the tool bar.

I -i0x]

0.0 0.5 1.0 1.5 20 2.5 3.0 35

Curve window with one variable

You will notice that the waveform "FREE" has the same shape as the data set s1ope, but all its values have
been decreased by the mean value of sIope.

© 2026 imc Test & Measurement GmbH imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10
Page 30



Data Editor

Chapter 4

4.15 Data Editor

Select "FREE" in the variable list, which you have previously generated in the chapter
o-8|@ 9@ Calculations| s 1. Then select the icon "Data Editor" in the Variables toolbar.

Standard ]

A new window appears. A table listing the individual numerical values of the data set "FREE" is found in the left

column.
B FAMOS Data Editor - [Table1] O] x|
: |:| Table Edit Column Display Window 7 - B x
BRI EEE: 370239 ]
[=] Column 2 Column 3
ﬂ -
le-006 970133
2e-006 9.70053
3e-006 970025
4e-006 9.70077
Se-006 970233
Ge-006 970521
Data Editor

Use the scroll bar on the right side to view further numerical values. Close the window.

Reference
Chapter 'Data Editor'.

© 2026 imc Test & Measurement GmbH

imc FAMOS 2026 - Getting Started, Doc. Rev.: 1 - 2026-04-10

Page 31



Saving results

Chapter 4

4.16 Saving results

Select "FREE" in the variable list and "Save Individually..."

in the menu "Variable". A dialog box appears for

entering a file name under which the variable should be stored. Set the file format to "imc FAMOS ". The file
"FREE.DAT" is created by selecting <Save>. This data set may be reloaded later.

Savein: I . Dat

g

Fecent Places

-

Desktop

Libraries

[y

Computer

1o

¥ save Data File (FAMOS Format) x|
5161 ok
Mame = |v| Date modified |v| Type |*|
. asC 3/21/2013 12:55... File folder
. events 1192012 12:10... File folder
|| EXPERIM 12/12/2012 2:00... File folder
. MyMeasurement 12/5/2013 2:44PM  File folder
. Vibration 12/6/2012 3:52PM  File folder
s 3/21/2013 12:52... File folder
b file.dat 12/1/2011 3:03PM  imc Mefidaten
B~11.1_w01218_MX R.dat 7/27/2012 11:14...  imc MefBdaten
B~ ADHISTO.DAT 6(7/1996 2:00 AM  imc Mefidaten
B ADSINE.DAT 6(7/1996 2:00 AM  imc Mefidaten
bl ADSINUS DAT 6258/1933 2:00 AM  imc Melidaten
) ansteuerung. dat 9/13/2012 11:54... imc Mefdaten
b ANSTIEG.DAT 6258/1993 2:00 AM  imc Melidaten -
1 | 3
File name: Free dat J Save
Save as type: FAMOS (*dat) |
&I
Comment: opkions. .

Reference

Chapter 'File Management'.

Dialog "Save File"

4.17 Deleting variables

The variables "FREE", "Maxim" and interpol are no longer needed and should be deleted from the Variables
list. First select these variables in the Variables list, then select "Delete" in the menu "Variable". The only entry
remaining is the variable slope.
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4.18 Spectrum

Load file "SIN3.DAT". Display the waveform by pressing function key F4.

m'
1000-
500-
|:|_
_500-
-1DDD_I | | | 1 |
0 2 4 & 2 10
ms

Curve window displaying variable "sin3"

The data set contains several periods of a sine-shaped signal, which has a strong third harmonic (second
harmonic oscillation). The distortion of the signal around its zero passages is typical for such a curve.

Enter the following formula to calculate the spectrum of the variable "SIN3":
SPECTRUM = Spec (SIN3)

The function "Spec" is found e.g. int he branch Analysis\Spectral Analysis\General. Double-click on this line in
the functions list, as well as on the variable "SIN3" in the variable list. Complete the formula using the
keyboard.

Execute the formula. "SPECTRUM (MP)" appears in the variables list. A complex variable was generated in
Magnitude / Phase (MP) representation.

Press function key F4 to display the spectrum magnitude in the curve window.
mf
350 -
300-
250-
200-
150 -
100-

50—
0-

I I 1 I l
0 5 10 15 20 25

Curve window displaying magnitude of spectrum
The magnitude of the spectrum exhibits a strong fundamental wave and a somewhat smaller second harmonic
oscillation.

Note that the fundamental wave has a somewhat smaller amplitude than the signal "SIN3". The amplitudes of
the oscillations correspond to those which would be exhibited by a selective voltmeter.
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0 Note

The Spec function is based on Fast-Fourier-Transformation, which is the function FFT() in the same group.
These calculations normally require additional parameters such as windows and window widths. As a quick
way to enter the parameters, they are entered globally under Options.There, you will set up the data
window and decide whether to interpolate the data set to obtain a number of points which is the nearest
power of 2, or to fill the data set with zeroes. In the example, the window was set to "Square" and "Fill with
zeroes" was deactivated.

4.19 Complex data sets

If "Spectrum.M" and "Spectrum.P" are not indicated in the Variables list, move the mouse pointer into the
variable box and right-click the mouse. Click on "Show Components" in the context menu.

Variables on o, Browser | &
Standard |Measurements| ) O - [ |
- (& |-n_ﬁ 4 @ | (i} | r & Spectrum= F
il slope '
N Interpal
1N Free
L sin3
W ..U.Lu E':I'lFil_h'l i {Mp}
S s
lad  Show
i) Properties
[T] Data Editor
Il Delete
Functic H save.. (=
(=]
Favori @ Group... atesl
[L: ;'g Ungroup ! 4
i S R
O Display options Sort alphabetically
i & Flayback (sound) Sort group contents
= 'il: #/  Make permanent Expand groups by default
?---‘i‘lHJ Lip 0he o pi ST
Al Tpal Splir "
i) Red Red e

This menu item is checkmarked if and when it is active. Additional entries now appear in the Variables list:
"SPECTRUM.M" and "SPECTRUM.P". These are the magnitude and phase components, respectively, of the
complex data set.
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Select the entry "SPECTRUM.P" in the Variables list by clicking once. Press function key F4 to display the phase
of the spectrum in a curve window.

T =S
: File Edit Configuraton Options Extras
Degr

o

-100-

-150- \
I I I I

0 5 10 15 20 25
kHz

Curve window with phase of spectrum, unscaled
The phase spectrum should be displayed from -180° to +180°.
Double-click in the space between the y-axis labeling in the curve window SPECTRUM.P. A dialog appears for
scaling the y-axis.

Under "Range selection", select "Fixed Range: min, max" from the menu "Range", and enter in the
corresponding text boxes Minimum = -180 degrees, Maximum = 180 degrees and Tick selection = "Ticks at fixed
distances" "Tick distance" = 90.

=

I Arrangement " Text " Attributes l
Aues List @
]
(I .~ " Fange selection: IFixed range: min, max

Al SPEKTRUM.p Minirnurn [Degr] |-180

b airmumn [Degr]; I1 20

Tick zelection ITil:ks at fined diztances

Tick diztance [Dear]:

Small ticks

Crder of magnitude:

Dialog for scaling the y-axis

Click on <OK> to close the dialog.
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aseeron RI=TEY
Degr
180-
50 -
0-
00—
-180-
1 | | | | |
0 3 10 15 20 25
kHz

Curve window with phase of spectrum, scaled

imc FAMOS now attempts to display the specified range from -180° to +180° with appropriate axis labels.

4.20 Creating sequences

A sequence (also called a macro) is a series of operations which imc FAMOS executes automatically in the
specified order. Frequently used series of operations can be automated by creating sequences.

Suppose, for example, the "frequency" of signal "SIN3" is to be found. Here we will define the "frequency" as
the maximum oscillation occurring in the spectrum of the signal.

First open a new, empty sequence. Right-click the mouse over the Editor box's title bar and select the item
"New" in the context menu which then appears. Alternatively, you can use the combination of keys
"CTRL"+"N" or the corresponding icon at the upper left of the Editor box's toolbar.

A new tab then appears in the Editor box's title bar, "UnnamedQ". This is then active and the sequence it
pertains to (which is empty at the moment) is displayed. Any other sequences, whether newly created or
already opened, would be displayed in the same way; to move between sequences, simply click on the tab in
the title bar which is associated with the sequence desired.

First, activate the standard Editor box (the tab all the way to the left) and select the previously entered
formula
SPECTRUM = Spec (SIN3)

using the mouse. Via the context menu or by means of "CTRL"+"C", copy the formula text to the Windows
Clipboard. Switch back to the new sequence and enter the formula text into the sequence as the first line by
way of the context menu or "CTRL"+"V".

d Browser | =/ Input
OO-@| ] B
B  Spektrum = Spec(sin3)

Sequence Editor (with command)
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Now enter the following formula in the next line:

Freq = Pos( spectrum.m, Max (spectrum.m))
The x-position of the spectrum's maximum magnitude is determined. Execute this formula once as a test by
double-clicking in the command line and then clicking on the arrow key (appearing at the left of the
command currently in readiness), or alternatively, CTRL + ENTER. Correct any errors if an error message
appears.

Now enter the line
SHOW freq

in the text window. This command displays the variable "FREQ" in the curve window.
You have created a sequence consisting of three commands.
3 Browser | |=| Input
DovE| O] BE
Spektrum = Spec(sin3)

FREQ = Pos( SPEKTRUM.M, Max (SPEKTRUM.M))
Show FREQ

SENER

Sequence Editor

4.21 Executing sequences

First delete the variables created in the sequence.
Select entries "SPECTRUM...MP" and (if present) "FREQ" and then select "Delete" in the menu "Variable".

Now select from the context menu (accessed by right-clicking the mouse over the Editor box's title bar) the
menu item "Execute". Here, too, you have the alternative to use the keyboard ("F7") or the corresponding icon
in the editor box's toolbar.

The sequence is now carried out, starting from the first line.

At the end of the sequence, a single value window is displayed indicating the calculated frequency.

d Browser | |=| Input

Do G =

)l B, 2 B

5 Spektrum = S 3) [ Run sequence (F7)
FREQ = PEKTRUM. UM.M))
Sho Q

|
I, FREQ — O
FREQ = 97656 Hz

Single value
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4.22 Changing sequences

The procedure introduced for determining the frequency works only for signals with a relatively small offset.
Therefore, the signal's mean value shall be removed.

Change the first line in the Sequence Editor as follows:
SPECTRUM = Spec( SIN3 - Mean (SIN3))

The calculated data set "SPECTRUM" should automatically be deleted because it is used as an intermediate
result in the sequence. Enter the following line at the end of the Editor box:
Delete spectrum

Restart the sequence.
d Browser | |=| Input
Oov@| ] A
Spektrum = Spec(sin3)
FREQ = Pos( SPEKTRUM.M, Max (SPEKTRUM.M))

Show FREQ
Delete Spectruﬂ

Sequence-editor

) 2 EF B

4.23 Saving sequences

Select the menu item "File" / "Save" or right-click the mouse on "Input" and then "Save As...". Save the
sequence under the name "Frequency.SEQ".

O Browser | =] Input Alternatively, you can save the sequence by clicking on the
bo-@ 2| B! BEEr B diskette icon in the Editor.
Spek Spec(sin3)

FREQ = Pos
Show FREQ
Delete Spectruﬂ

KTRUM.M, Max (SPEKTRUM.M))

3 Browser | =|Input = Freque

‘ ‘ x* Close the sequence you just made by clicking on "X", or
ODd~E| %

- t = By .
=+ | | Close £ 1 select the context menu item "Close".
1 Epek = Spec(sin3)
2 = Pos{ SPEKTRUM.M, Max (SPEKTRUM.M))
3 Show FREQ
A

Delete Spectrum

You can now run the saved sequence directly. To do this, enter the command:
SEQUENCE Frequency.SEQ

The file "Frequency.SEQ" is opened in the background and the sequence it contains is executed.
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4.24 Al-Assistant

The FAMOS Al assistant supports you in programming sequences and helps with general questions about the
operation of FAMOS. As with other Al assistance systems, communication takes the form of a written dialog
("chat"). You formulate your question in text form, receive the answer in text form and, if necessary, can refine
the assistant's answers step by step and tailor them to your problem by asking further questions.

The Al assistant is available in the Professional and Enterprise editions and requires an Internet connection.
The required services and applications are made available within Microsoft's Azure cloud platform.

The Al assistant has the status "experimental" in version 2025 and is in constant and progressive further
development. imc reserves the right to temporarily switch off the service for maintenance purposes and
therefore does not guarantee 100% availability.

. The Al tool window contains the display of the
current call history o in the upper area. Below
o Generate code to generate a sinusoidal signal with frequency 50 Hz, amplitude 2 'v' and

1004 sampling time. this is the input window e, in which you can
formulate your requests. To the right of the input
; Generate a sinusoidal signal o
=2 ; requested amplitude
= 5

v window, you will find the "Send" button 9,

i -] ; requested frequency (unit "Hz') . .
dt = 0.0061 ; requested sampling time (unit 's’) which you can use to send the current request in
sine_wave = U * sin(Ramp(®, dt, (1/f)/dt) * PI2 * f) ; create the sine wave the |nput WlndOW to the ass'stant

SetUnit(sine_wave, "s", @) ; set the x-unit to seconds

Copy || Insert e
Iy suggestions may be inaccurate The Assistant's response may contain sections
Please rate my answer: @ @ @ that contain direct sequence code (highlighted in
gray @). Right-click in these sections to open a
context menu with the usual text processing
commands such as "Copy"/"Paste"/"Delete".

@' Cl‘ =R D.ﬂ\ttach code
Generate code to generate a sinusoidal signal with frequency 50 Hz, amplitude 2 'V' and

10025 sampling time. »

Below the code sections you will find the "Copy" and "Insert" buttons e "Copy" copies the entire code to the
Windows clipboard, from where it can be inserted into other programs or FAMOS itself using "Paste". With
"Paste", the code is inserted into the active sequence editor window (if an area is selected there, the selection
is replaced, otherwise it is inserted at the cursor position).

op» Reference Al-Assistant

Please read the detailed description in the FAMOS manual to find out more about the functions and
possibilities of the Assistant.
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4.25 Creating documention with Panels

After analysis of the measured data, documenting the results is usually the next step. This means not only
saving the file, but also the creation of various documents (either digital or hard copy) for the saving and

presentation of the results.

", Create a report page for documentation of results.

Procedure

! Load the data set slope and use the following command lines to obtains its statistics values:
FAMOS
LOAD slope
Maximum = Max (slope) ; Group: Analysis > Statistics > Generic
Minimum = Min(slope)
MeanValue = Mean(slope)

|£| o Create a Report page as a Panel. Go to the menu item File-> New-> New Panel-> Report (Portrait).

e |n the tool window at the bottom left, select Standard>Label and then in the Report page drag open

a frame for it (holding down the left mouse button).

e Next, leave the tool window and go to the Properties window. In the text box under the item Text,

enter a title for your report. Under Font, you can alter the font and font size.

e Go to the page Edit under General and use "Insert Widget" > Standard > Image to add a placeholder

for an image to the report. In the Properties window under Image, select a picture or logo on your
hard drive and have it displayed.

o |n the Standard variables list, highlight the channel "slope", drag it to an empty area in your report

and release the left mouse button there. Select Standard for a standard curve window.

o Select the results Maximum, Minimum and MeanValue in the Variables list and drag them together

to below the curve window of the channel "slope". After releasing the left mouse button, select the
option "Numerical".

e To see the complete page, right-click at the bottom right in the Zoom box on the rectangle.

|gl | Save this page as part of the Panel using File -> Save and assign it the filename FirstPanel.panel.
=L | Export the report as a PDF using File -> Export as PDF under the name PDFReport.pdf.

Result
", You have created as report which was also exported as a DIN-A4 page PDF.

0 Within a Panel, you can also create multi-page reports and of course export all of them in PDF.
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I o
Panel (Design)

Exta  View  Page ]Ed'rtl

ﬁ ¥ Undo [Position] 4o Cut & & - |
L % -
Exit Design-mode Insert @ 2l 3 Delete Insert B N
Widget~ (@ Paste new page~ [ By~ Re-align to grid

General Page Arrange ... Grid

Variables | @ Browser | =l Input | [=# Panel1[Code] ‘ |#] Panel1* x v
Standard |Meagurement5| O-C~@® S | . Design-Mode ‘ Options ~ ) B~ & [
d-@@9ma|y

slope

Maximum (=36.9745)
Minimum (=9.70239)
Meanvaluewert (=17.79)

Curve window

Standard SVl
- : Minimum 97024V
:E;‘;er OMeanvaluewert 177900V ©

=] Image

[ Table

Pushbutton

Switch

Editbox (Single ing)

=| Editbox (Muld line)

EZ Listbox (Single selection)
E7 Listbox (Multd selection)
Droplist

| =& Combobox

Shapes

| Tools | Properties

Ready  Zoom:auto o)l ) @ CAPS NUM
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4.26 Favorites

Formulas or sequences used frequently can be entered into a list of favorites, in order to save on time spent
typing.

Open the context menu by right-clicking the mouse over the list and select the menu item "New Entry". In the
dialog which then appears, enter a short, descriptive name under "Caption", e.g. "1/3-octave analysis". The
actual text is entered in the Statement box. You can, for example, enter the formula manually, or use "Copy"
and "Paste" to get it from the editor box, or even easier, use the formula input box's context menu to transfer
in the currently active line in the editor box. Now you can also enter a short description and a help text.

Caption: 1/3octave analysis

Kind: Statement

Statemert:
gequence Third_Octave seq

Description::
Runs a 1/3 Octave-analysis

Help:

Starts sequence third_Octave seq. Afile to be selected is
opened, uhdergoes 1/3-octave analysis and the results are
displayed.

Dialog for definition of "Favorites"

The option "Execute!" ensures that the entry will be executed upon double-clicking on it.

The new entry is now shown in the Favorites list; double-clicking on it is enough to have the sequence
"Third_Octave.SEQ" carried out.

Reference

Chapter 'User Interface', Section 'Administering Favorites'

You have now successfully completed the Tutorial.
We wish you much success in working with imc FAMOS .
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An Axiometrix Solutions Brand

Contact imc

Address

imc Test & Measurement GmbH

Voltastr. 5

13355 Berlin

Phone: (Germany): +49 30 467090-0
E-Mail: info@imc-tm.de

Internet: https://www.imc-tm.com

Tech support

If you have problems or questions, please contact our tech support:

Phone: (Germany): +49 30 467090-26
E-Mail: hotline@imc-tm.de
Internet: https://www.imc-tm.com/service-training/

Service and maintenance

Our service team is at your disposal for service and maintenance inquiries:

Phone: (Germany): +49 30 629396-333
E-Mail: imc-service@axiometrixsolutions.com
Internet: https://www.imc-tm.com/service

imc ACADEMY - Training center

The safe handling of measurement devices requires a good knowledge of the system. At our training center,
experienced specialists are here to share their knowledge.

E-Mail: schulung@imc-tm.de

Internet: https://www.imc-tm.com/service-training/imc-academy

International partners

You will find the contact person responsible for you in our overview list of imc partners:

Internet: https://www.imc-tm.com/imc-worldwide/

imc @ Social Media

https://www.linkedin.com/company/imc-test-&-measurement-gmbh

https://www.linkedin.com/company/famos-test-measurement-data-analysis

https://www.youtube.com/c/imcTestMeasurementGmbH



mailto:info@imc-tm.de
https://www.imc-tm.com
mailto:hotline@imc-tm.de
https://www.imc-tm.com/service-training/
mailto:imc-service@axiometrixsolutions.com
https://www.imc-tm.com/service
mailto:schulung@imc-tm.de
https://www.imc-tm.com/service-training/imc-academy
https://www.imc-tm.com/imc-worldwide/
https://www.linkedin.com/company/imc-test-&-measurement-gmbh
https://www.linkedin.com/company/famos-test-measurement-data-analysis
https://www.youtube.com/c/imcTestMeasurementGmbH

	Table of contents
	1 General introduction
	1.1 Before you start
	1.2 Tech support
	1.3 Service and maintenance
	1.4 Legal notices
	1.5 imc Software License Agreement

	2 Foreword
	3 Setting up - Software
	3.1 System requirements
	3.2 Installation
	3.3 Start

	4 Tutorial
	4.1 Introduction
	4.2 Starting FAMOS
	4.3 Directories
	4.4 Loading Files
	4.5 Showing Variables
	4.6 Zoom
	4.7 Unzooming
	4.8 Measure
	4.9 Properties
	4.10 Interpolation
	4.11 Two channels in Curve Window
	4.12 Changing a Formula
	4.13 Single Values
	4.14 Calculations
	4.15 Data Editor
	4.16 Saving results
	4.17 Deleting variables
	4.18 Spectrum
	4.19 Complex data sets
	4.20 Creating sequences
	4.21 Executing sequences
	4.22 Changing sequences
	4.23 Saving sequences
	4.24 AI-Assistant
	4.25 Creating documention with Panels
	4.26 Favorites

	Index
	Contact imc

